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GeoDam-BREACH 
The Geospatial Dam Break, Rapid Emergency Action Plan, Consequences and Hazards (GeoDam-
BREACH) Geographic Information System (GIS) toolset for ArcGIS was developed for the Federal 
Emergency Management Agency (FEMA) by Risk Assessment, Mapping, and Planning Partners (RAMPP), 
a joint venture of Dewberry, URS Corporation and ESP Associates.   

FEMA does not provide support for this software to non-FEMA users. 

This document provides references to product names that are trademarks or registered trademarks of 
their respective owners.  Use of specific product names does not imply official or unofficial 
endorsement.  Product names are used solely for the purpose of identifying products available in the 
public marketplace. 

Microsoft and Windows are registered trademarks of Microsoft Corp. 

ArcGIS, 3D Analyst and Spatial Analyst are trademarks of Environmental Systems Research Institute 
(ESRI), Inc. 
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Introduction 
The Geospatial Dam Break, Rapid Emergency Action Plan, Consequences and Hazards (GeoDam-
BREACH) is a suite of ArcGIS tools designed to support the development of simplified dam break studies, 
Risk Mapping, Assessment and Planning (Risk MAP) datasets, loss of life assessments, Emergency Action 
Plans (EAPs) and EAP map panel creation. 

This version of GeoDam-BREACH can be used for various workflows including: 

• Simplified Dam Break Studies
Supports the use of the National Weather Service (NWS) Simplified Dam Break Model 
(SMPDBK) (Reference 1).  SMPDBK is supported within an ArcGIS environment, enabling 
the automated creation of model geometry, model execution and inundation 
delineation. 

• Risk MAP Datasets
Supports the creation of non-regulatory Risk MAP datasets in accordance with draft 
Risk MAP guidance available at the time of development (Reference 2).   Risk MAP 
datasets can be derived from studies created within GeoDam-BREACH using SMPDBK, 
or from other studies created outside of GeoDam-BREACH. 

• Loss of Life Assessment
Supports loss of life assessments for dam failure using either the Department of 
Homeland Security (DHS), 2011 document: Dam Sector: Estimating Loss of Life for Dam 
Failure Scenarios (Reference 3) Flood Severity method or the Brown and Graham 
method as referenced in the U.S. Bureau of Reclamation (BOR) Dam Safety Office (DSO) 
Document 99-06 (Reference 4).  Loss of life assessments can be performed with user 
provided population polygons and arrival time grids for the failure event.   

• EAP Map Panel Creation
Supports the creation of consistent EAP map products using the Draft Federal Guidance 
for Inundation Mapping of Flood Risks Associated with Dam Incidents and Failures 
(Reference 5).   Panel scheme and individual map panels are created from either a 
default or user provided template.    

• EAP Development
Supports the creation of consistent EAP documents using the Natural Resources 
Conservation Service (NRCS) EAP Template (Reference 6) and FEMA publication P-64, 
Federal Guidelines for Dam Safety: Emergency Action Planning for Dams, July 2013 
(Reference 7).   

This version of GeoDam-BREACH includes several multi-media tutorials.  These can be accessed by 
clicking on the multi-media icon: 

This User Manual supports GeoDam-BREACH version 2.0 for ArcGIS version 10.0. 
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Requirements 
Users must have a thorough understanding of the NWS SMPDBK program, hydraulics and general dam 
safety knowledge, including the development of breach parameters, EAPs and consequence 
assessments including loss of life analysis.  A working understanding of ArcGIS, 3D Analyst and Spatial 
Analyst is also required. 

Software Requirements 
GeoDam-BREACH requires ArcGIS Editor or Info version 10.0 with the Spatial Analyst and 3D Analyst 
extensions.  The inundation polygon smoothing option is available only at the ArcGIS Info level. Separate 
installation of NWS SMPDBK is not required because it is included in the GeoDam-BREACH installation 
package.  It is recommended that all previous installations of SMPDBK be removed. In order to use the 
Loss of Life assessment tools, Microsoft® Word© 2003 or greater is required.  To use the EAP Mapping 
tools, Adobe® Reader© is required. Adobe® Reader© can be downloaded 
from http://www.adobe.com/products/reader.html. To use the EAP document generator, both 
Microsoft® .NET Framework 4.0 and Word© 2003 or greater are required.  Microsoft® .NET Framework 
4.0 can be downloaded from http://www.microsoft.com/download/en/details.aspx?id=17851.  To 
utilize the multi-media tutorial functions of GeoDam-BREACH, Microsoft Windows Media Player© is 
needed and can be downloaded from http://windows.microsoft.com/en-us/windows/windows-media-
player 

Computer and Operating System Requirements 
Computer requirements are consistent with those for ArcGIS version 10.0.  GeoDam-BREACH is 
compatible with both Windows XP© and Windows 7© operating systems, although it is optimized for the 
Windows 7© operating system.  

Data Requirements 
GeoDam-BREACH minimum data requirements vary by workflow as specified within this document.  

Digital Data Requirements 
For development of a simplified inundation study and Risk MAP datasets, the minimum digital data 
requirement is a single Digital Elevation Model (DEM) in ESRI Grid format that covers the entire extent 
of the area to be studied, including the resultant inundation area.  The user must carefully review and 
understand the accuracy of the input grid and evaluate its suitability for each study performed.  Other 
datasets, including downstream river lines, reservoir polygons and cross sections can be imported using 
basic GIS functionality from other datasets, or may be developed by the user for use with GeoDam-
BREACH.  For EAP map panel creation and EAP development, the minimum data requirement is an 
inundation polygon. 

Non Digital Data Requirements 
All workflows require basic information pertaining to the dam, including dam name, dam type, location 
etc.

http://www.adobe.com/products/reader.html
http://www.microsoft.com/download/en/details.aspx?id=17851
http://windows.microsoft.com/en-us/windows/windows-media-player
http://windows.microsoft.com/en-us/windows/windows-media-player
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GeoDam-BREACH Installation – Version 2.0 

The GeoDam-BREACH installation includes a modified version of the NWS SMPDBK program, designed to 
run on both 32-bit and 64-bit computers and modified to support up to 500 cross sections.    

Users with existing installations of GeoDam-BREACH will need to remove the current Add-In (this 
includes beta testers).   

To remove existing GeoDam-BREACH Add-In: 

Windows XP: 

1. Click Start, click Control Panel, and then double-click Add or Remove Programs.
2. In the Currently installed programs box, click the GeoDam-BREACH Toolkit 1.0.0.0, and then click

Remove.
3. You’re prompted to confirm the removal of the GeoDam-BREACH Toolkit, and click Yes.

Windows 7: 

1. Open Programs and Features by clicking the Start button , clicking Control Panel, and then clicking
Programs and Features.

2. Select GeoDam-BREACH Toolkit 1.0.0.0, and then click Uninstall. If you're prompted for an administrator
password or confirmation, type the password or provide confirmation. You’re prompted to confirm the
removal of the GeoDam-BREACH Toolkit, and click Yes.

To install a new GeoDam-BREACH Add-In (after removing existing Add-Ins and for first time installs) 

1. Download and save the executable FEMA_GeoDam-
BREACH_v2.exe to your computer.

2. Double click on FEMA_GeoDam-BREACH_v2.exe
and click on Yes to install GeoDam-BREACH.  It is
recommend to use default destination folder:
Win 7 : C:\Program Files (x86)\GeoDamBreach
Win XP: C:\Program Files\GeoDamBreach
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3. Open a new ArcMap document and select
Customize->Add-In Manager -> ‘Options’
tab and then select the GeoDamBreach
folder (installation folder created during
step 2)

4. Click on Customize (in the bottom right
corner of window) and then click the
Commands tab and select Add-In Controls

5. Click on FEMA GeoDam-BREACH – and drag the command icon onto a toolbar of your choice as
illustrated below
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6. Save the MXD – Any MXD you open should have the FEMA GeoDam-BREACH Tool Button at that
location which can be used to launch the toolset.

Working with GeoDam-BREACH 

GeoDam-BREACH Workflows 

GeoDam-BREACH has five major workflows that can be performed in sequence or individually where 
appropriate: 

1. SMPDBK Pre and Post Processing Workflow

The SMPDBK Pre- and Post-Processing Workflow allows users to generate SMPDBK input data 
within GIS; execute SMPDBK on the fly; and then import the SMPDBK output back into GIS to 
automatically create inundation polygons. 

2. Risk MAP Datasets Workflow

The Risk MAP Datasets Workflow allows users to automate the generation of Risk MAP datasets 
for each dam.   This can include dams that have been analyzed using the SMPDBK Pre- and Post-
Processing Workflow, as well as dams that have been analyzed using other models, including the 
U.S. Army Corps of Engineers Hydrologic Engineering Center River Analysis System (HEC-RAS) or 
various 2-D models.  This data can then be used for non-regulatory datasets, as well as for 
supporting the Loss of Life Assessment, EAP Mapping and EAP Development Workflows. 

3. Loss of Life Assessment Workflow

The Loss of Life Assessment Workflow allows users to automate probable loss of life estimates 
using the Flood Severity Method (Reference 3) or the Brown and Graham Methodology 
(Reference 4).  Users must supply polygons attributed with population counts and provide 
information pertaining to the dam and unique downstream conditions, including the flood 
severity, understanding of severity and determination of when a breach warning would be 
initiated. 

4. EAP Mapping Workflow

The EAP Mapping Workflow allows users to automate the development of a mapping panel 
scheme and the creation of individual mapping panels.   The EAP Mapping Workflow requires an 
inundation polygon and optional base map data.  Other data, including Risk MAP Datasets, can 
be leveraged to automate annotation and development of individual panels.  For EAP map panel 
layout and formatting, GeoDam-BREACH uses the guidance provided in the Draft Federal 
Guidance for Inundation Mapping of Flood Risks Associated with Dam Incidents and Failures 
(Reference 4). 
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5. EAP Development Workflow

The EAP Development Workflow allows users to semi-automate the creation of an EAP by using 
a simplified version of the NRCS EAP template (Reference 5).  GeoDam-BREACH provides users 
with a simplified environment for developing an EAP document efficiently and consistently. 

GeoDam-BREACH Workflow Relationships 
The following diagram illustrates the relationships between the five workflows and how GeoDam-
BREACH can utilize the simplified dam break studies developed during Workflow 1; or can leverage more 
detailed inundation data developed outside of GeoDam-BREACH for Workflows 2 and 3. 

GeoDam-BREACH Dashboard 
SMPDBK Pre- and Post-

Processing 

Inundation studies from outside 
of GeoDam-BREACH 

EAP Development 

Risk MAP Datasets 

EAP Mapping 

Loss of Life Assessment 
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Loading GeoDam-BREACH 
GeoDam-BREACH is launched by clicking the GeoDam-BREACH icon on a toolbar.  This location will vary 
depending on where users choose to add the tool during installation. 

GeoDam-BREACH Dashboard 

The GeoDam-BREACH Dashboard is where studies are managed and set up.   The Dashboard provides 
users with a simple window in which dams can be identified, individual workflows can be launched and 
the overall progress of an analysis can be tracked.  

New studies can be created and old studies 
can be opened from the Dashboard 

Dams can be named, added and removed 
from the project area of the dashboard 

Individual workflows can be launched by 
selecting a dam from the list and clicking 
the launch buttons, which are color coded 
to indicate progress of the workflow 

All dams within a study are listed in the 
Dashboard 

The user can return to the List of Dams at 
any point.  The user can also open the 
GeoDam-BREACH .dbk folder at any time. 

ArcMap Extensions 
3D and Spatial Analyst extensions for ArcMap are required for some GeoDam-BREACH workflows and 
functions.   Ideally, both extensions should be enabled prior to starting a GeoDam-BREACH study. 
However, if these extensions are not readily available to users, GeoDam-BREACH can still be used with 
limited functionality.  Table 1 summarizes where these extensions are required and the potential 
limitations if either extension is not available. 

ArcMap Editor Toolbar 
The ArcMap Editor toolbar is required when developing SMPDBK models.   



8 

The Editor toolbar contains the various commands needed to edit data within ArcMap. Using the Editor 
toolbar, users can start and stop editing data and save those edits. To edit data, users need to add the 
Editor toolbar to ArcMap. 

To display the Editor toolbar, click the Editor Toolbar button  on the Standard toolbar. 
Alternatively, right click in the top margin of ArcMap and check the Editor Toolbar. 

The toolbar should now appear. 

Table 1. ArcMap Extension Requirements for GeoDam-BREACH 
Workflow 3D Analyst Spatial Analyst 

Workflow 1 – SMPDBK Required to smooth inundation Required 
delineation (SMPDBK models can 
be created without extension 
and unsmoothed inundation 
polygons can be created) 

Workflow 2 – Risk MAP Required if new raster data sets Required if raster datasets are to 
are created from Workflow 1 or be created 
external 1D features 

Workflow 3 – Loss of Life Not Required Required 
Workflow 4 – EAP Maps Not Required Not Required 
Workflow 5 – EAP Development Not Required Not Required 

To enable Spatial and 3D Analyst extensions, select Customize from the ArcMap main menu and then 
select Extensions.  Enable Spatial and 3D Analyst extensions by checking the boxes to the left of their 
name in the Extensions window, as illustrated below:  
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GeoDam-BREACH Study 

GeoDam-BREACH is designed to support the analysis of either single or multiple dam assessments.  It 
is specifically designed to efficiently manage data in a consistent, organized manner to preserve all 
supporting data, thus enabling it to be effectively stored, queried and retrieved, as needed.   

Within GeoDam-BREACH, a Study is defined as an assessment or collection of one or many dams.  All 
related data are stored in a user-defined folder with the suffix .dbk, which enables users to recognize 
that folder as a collection of dams assessed using GeoDam-BREACH.  Within this folder, GeoDam-
BREACH creates a standard data structure to support assessments and encourage consistency 
between multiple dams for all workflows.  Users can choose which dams to include within a study.  A 
study may be limited to geographic areas, such as Hydrologic Unit Codes, counties, regions etc., or 
may be broken out based on the work of various individuals or groups. 

Creating a GeoDam-BREACH Study 
GeoDam-BREACH features a multi-media tutorial for creating a new GeoDam-BREACH study.  

Just look for the  icon. 

1. To create a study, select New Study from the left side of the Dashboard.  The new study entry
form will appear in the Dashboard and users must enter the location and name as illustrated
below.

2. The Study Spatial Reference refers to the coordinate system that GeoDam-BREACH will use for
all dams studied.   GeoDam-BREACH has been tested using both Geographic and projected
coordinate systems in both feet and meters, although the user is strongly recommended to
verify that any calculations performed by GeoDam-BREACH appropriately handle vertical and
horizontal units.   A coordinate system must be selected before proceeding.

3. The Study Description is an optional data entry whereby the user can describe the GeoDam-
BREACH study.
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2. Enter the name that will be used for the 
study folder

4. Provide a description for the
study (optional)

3. Select the spatial reference that will be 
used for the study

1. Select the root directory where you 
would like the GeoDam-BREACH study to
be saved

5. Select Create when ready to proceed.
GeoDam-BREACH will create the study folder

The study folder can be opened at any time 
by clicking Open Project Folder.  

Click for multi-media tutorial 

4. By clicking Create, GeoDam-BREACH will now create a study folder which will be used to store
all data.  The folder takes the Study Name entered into the Dashboard upon creating a New
Study.   The Study Name folder will be given the suffix .dbk, which indicates that it is a GeoDam-
BREACH study folder.   In the above example, the Study Name FloodCountyRiskMAP was used.
Therefore, the study folder will be named FloodCountyRiskMAP.dbk.

After clicking Create, GeoDam-BREACH may take up to 2 minutes to create the database and
folder structure.  Please do not click or perform any ArcGIS functions until the following
message appears:
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Adding a Dam to GeoDam-BREACH 
One or more dams can be added to a GeoDam-BREACH study by clicking on the location of the dam.   At 
least one dam is required to perform any of Workflows 1 through 5.   

1. To add a dam to the study, populate the NID_ID and Name fields in the Project attributes area
and select Add Dam Point from the Dashboard.  GeoDam-BREACH will now prompt you to click
on the location of the dam.

1. Enter a unique ID for the dam and the 
dam name.  The National Inventory of
Dams ID is suitable for this purpose, if
available (no special characters #, /, @ etc)

2. Click on Add Dam Point and when 
prompted, click on the location of the dam
in ArcGIS (no special characters #, /, @ etc) 

3. Users can populate 
optional fields within 
Dashboard if desired.

Please note that neither the Dam NID ID or the Dam Name will accept special characters such as #, /, !, 
@ etc. This is because many ArcMap geoprocessing functions do not support special characters and 
will cause GeoDam-BREACH to fail.   

Once a dam has been added, it will be listed within the Dashboard and GeoDam-BREACH automatically 
creates a folder within the .dbk folder that adopts the NID_ID previously entered for the dam.  This 
folder will contain all GeoDam-BREACH data specific to that dam. 

Selecting the dam in the Dashboard will cause the workflow launch buttons on the left to change color 
to indicate the workflow progress for that specific dam.  Red generally indicates that a workflow has not 
been started or contains no data.  Yellow generally indicates that a workflow has been started, but has 
errors or omissions.  Green generally indicates that the workflow is complete.  Each workflow can be 
launched by simply clicking the launch buttons when an individual dam is selected.   
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Work Flow 1 – SMPDBK Pre- and Post-Processing 
The SMPDBK Pre- and Post-Processing Workflow is illustrated in Figure 1 

GIS Data Development for 
SMPDBK Geometry 

1. Create/Import downstream river line
2. Develop reservoir polygon or

determine volume/area
3. Create cross section cut lines
4. Create ineffective flow areas
5. Select/Enter dam and breach

information

Digital Elevation Model 

Did model layout 
provide suitable 

results? 

NO 

SMPDBK Inundation Study Complete 

Include Rating 
Curves and 

develop synthetic 
hydrographs? YES 

NO 

Import Rating Curves 

YES 

Create SMPDBK Input, 
execute SMPDBK and 
delineate inundation 
polygon 

Run Simulation 

Select Dam from GeoDam-
BREACH Dashboard and Select 
SMPDBK Workflow 

Figure 1. SMPDBK Pre- and Post-Processing Workflow 
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Input Data Requirements 
The minimum digital data requirement for the SMPDBK Pre-and Post-Processing Workflow is a DEM in 
an ESRI Grid or File Geodatabase (FGDB) formats.   The DEM is required to extract cross-section 
geometry of the downstream valley.   

Additional digital datasets that are not used to perform SMPDBK calculations can assist the development 
of Workflow 1 data by providing visual references. This can include aerial imagery, planimetric data and 
land-use data, all of which can help users make better engineering decisions when setting up the model.  

Where available, GIS datasets containing a continuous stream centerline, cross-section lines and/or a 
reservoir pool polygon can all be imported directly into GeoDam-BREACH during Workflow 1, effectively 
eliminating or minimizing the user’s need to develop these datasets. 

Information pertaining to the dam, breach event and reservoir conditions is required.  This includes the 
dam type (Earthen, Concrete Gravity, Concrete Arch), Breach Parameters (Optional: Breach Width, 
Breach Development Time) and reservoir area or volume. 

Using SMPDBK Pre- and Post-Processing Tools 
1. To launch the SMPDBK Pre- and Post-Processing Workflow, simply select the dam in the

Dashboard and click the SMPDBK launch button, as illustrated below:

1. Select the dam here

2. With the dam selected, click SMPDBK to launch the
SMPDBK workflow 
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Upon launching the SMPDBK Workflow, GeoDam-BREACH automatically creates the empty data 
structure needed to develop the geometry for a SMPDBK model.   This is stored in an FGDB within the 
individual dam folder.   

GeoDam-BREACH automatically creates an FGDB for 
the dam containing the spatial datasets needed to 
create an SMPDBK study 

Digital Elevation Models 

1. The DEM should be added to the ArcMap document (MXD) before proceeding with the SMPDBK
Pre- and Post-Processing Workflow by using the Add Data tool and selecting the DEM to be
stored in either ESRI Grid or FGDB format.

DEMs can be obtained from many sources including the National Elevation Dataset or various State, 
regional and local agencies.   Users must carefully evaluate the accuracy of the DEM to ensure that it 
is suitable for its intended purposes.  The DEM accuracy will greatly affect the accuracy of any 
GeoDam-BREACH study.     
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The DEM will be used to 
extract elevation-width data 
pairs needed for SMPDBK 

Basic Setup 
The Basic Setup is used to define layers and model defaults.   By default, the empty schema for Dam 
Points, Downstream River Line, Downstream Cross-Section Lines and Inactive Area layers are 
automatically created and selected to encourage the use of consistent file names and storage locations.  

The user must first select the Study Area DEM layer and specify its vertical units before proceeding.  

GeoDam-BREACH features a multi-media tutorial for selecting a DEM.    

Just look for the  icon. 



1. Select the DEM
and vertical units

2. Users can 
override the 
default cross
section N value

3. Users can 
override the 
default inactive 
area N value

4. Users can override the 
default flooding depth value 

GeoDam-BREACH 
automatically 
selects the default 
layers 

Click for multi-media tutorial 
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Default Cross Section Manning’s N and Inactive Manning’s N represent the global values that will be 
applied to all cross sections in the SMPDBK input.   

Inactive Manning’s N represents the Manning’s N value that will be applied to the portion of a cross 
section considered as dead storage or ineffective area.   The user defines these areas by using the 
Inactive Areas polygons. 

The Depth of Flooding (ft) represents the definition of a flood.  The depth of flooding is the depth at 
which the leading edge of the inundation is considered to have arrived.   
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Breach Parameter Setup 
When setting up breach parameters, users have two ways to define the final breach width and breach 
development time.   The Predefined Parameter Setup option enables users to simply specify the dam 
type from three options: Earthen, Concrete Gravity or Concrete Arch.  Default values are then applied 
for breach width and development time, as described in the SMPDBK documentation (Reference 1). 
The User Defined Breach Parameters option enables users to specify the final breach width and breach 
development time manually, enabling the use of more detailed methods for determining these 
parameters.   

Pool Elevation at Breach represents the elevation of the reservoir at the time that the dam begins to 
breach.   

Final Breach Bottom Elevation represents the final elevation of the breach. 

Non Breach Flow represents the flow going through the dam at time of failure not associated with 
the breach.  This can include turbine, spillway or overtopping flows. 

When using the Predefined Breach Parameter option, SMPDBK assumes the following default values 
for Final Breach Width, Time of Breach Formation (failure) and Final Elevation of Breach Bottom. 

 Breach Parameter Background Information 

Value Units Description Default 
3H for earthen dams 
5H for concrete gravity 
dams 

Br Feet Final breach width 
0.9 × maximum width 
of tailwater section for 
concrete arch dams 

H/10 for earthen dams 
H/40 for concrete 

tf Minutes Time of breach formation (failure) gravity dams 
H/50 for concrete arch 
dams 
Elevation of bottom of 

hr Feet Final elevation of breach bottom tail water (first) cross 
section 

Note: H is the difference (in feet) between the reservoir water-surface elevation when the breach 
commences to form and the final bottom elevation of the breach (hr) 
Source: “The NWS Simplified Dam-Break Flood Forecasting Model” (Reference 1) 
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GeoDam-BREACH features a multi-media tutorial for selecting Breach Parameters.   

Just look for the  icon. 

Using Predefined Parameter Setup 

1. Select predefined 
parameter setup
radial button

3. Enter the pool
elevation at breach

2. Select the dam type 
using the appropriate 
radial button 4. Enter the final

breach bottom

5. Enter the non-
breach flow from

6. Select the release 
type and event
descriptions (for
reference only)

Click for multi-media tutorial 

The Release Type and Event Description drop down menus allow users to enter the failure mode 
and failure event description.   Although not used in the calculations, this is used in the naming 
convention of digital datasets and features, and provides a permanent record of what the 
simulation represents. 
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Using User-defined Parameter Setup 

Click for multi-media tutorial 1. Select User Defined 
Parameters radial
button

3. Enter the pool
elevation at breach

2. Enter the user
defined final breach 
width and breach 
development time

4. Enter the final
breach bottom

5. Enter the non-
breach flow from

6. Select the release 
type and event
descriptions

Note that Final Breach Width represents a rectangular breach.  Users may choose to apply engineering 
judgment and enter Final Breach Width as an average breach width if the breach is assumed to be 
trapezoidal. 

As previously mentioned, the Release Type and Event Description drop down menus allow users to 
describe the failure mode and failure event description.  Although not used in the calculations, this is 
used in the naming convention of digital datasets and features, and provides a permanent record of 
what the simulation represents. 
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Reservoir Parameter Setup 
There are three options for the Reservoir Parameter Setup, which is used by SMPDBK to estimate the 
volume of water released during a breach.  Users can select which method to use from the three radial 
buttons.  The Reservoir Surface option enables users to provide or digitize a polygon representing the 
upstream pool of the reservoir at the time of breach.  GeoDam-BREACH stores this in the 
S_US_Inundation_AR feature class.  Alternatively, users can specify either the surface area or volume of 
the reservoir at the time of breach, thus eliminating the need to digitize polygons.  The SMPDBK user 
manual (Reference 1) provides details on how Reservoir Surface Area (As) and Volume are calculated. 

By default GeoDam-
BREACH will select the 
upstream Inundation 
polygon to calculate 
reservoir volume 

Select the Reservoir 
Surface option by 
clicking the appropriate 
radial button 

Or users can specify 
surface area 

Or users can specify 
reservoir volume 

Select the reservoir 
condition 

The Reservoir Condition drop down menu allows users to select the reservoir condition.  Although 
not used in the calculations, this is used in the naming convention of digital datasets and features 
and provides a permanent record of what the simulation represents. 



Preprocessing of GIS Data 
To Preprocess GIS data, users must use basic ArcGIS editing functions to create, at a minimum, River 
Centerlines and Cross Sections 

River Centerline (Required) 
The river centerline is the backbone behind the model cross sections and serves as the baseline to 
determine the distance from the dam and the distance between individual cross sections.  GeoDam-
BREACH requires a single-part river centerline to be digitized from the upstream toe of the dam to the 
downstream limit of study, which is stored in the S_DS_River_Ln feature class. 

If users have an existing streamline, it can be imported by selecting Import Layer -> River Line from the 
main Dashboard menu. 

1. To begin drawing or editing the river, select Start Editing from the Editor Toolbar.  If an ArcMap
document contains multiple editable databases, the user will need to select the DamBreach.gdb
FGDB under the Source section of the Start Editing window and click OK.   If there is only one
FGDB within the ArcMap document, then this step will be automatically skipped.
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Select DamBreach.gdb 
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2. To begin digitizing, select S_DS_River_Ln in the Create Features window that appears on the
right side of the ArcMap document.  With S_DS_River_Ln selected, begin to digitize the stream
centerline from upstream to downstream starting at the base of the dam and moving in the
downstream direction.

Select S_DS_River_Ln 

Begin digitizing the 
river centerline from 
the toe of the dam 

Digitize in the 
downstream direction 
by single clicking to 
create vertices, and 
double clicking to 
create the last vertex 
and finish line 

Click Create Features 

Note that it is not necessary, nor does it increase the accuracy of the SMPDBK study, for the 
S_DS_River_Ln to accurately follow the river centerline.  The S_DS_River_Ln should capture the centroid 
of the inundation flood wave that takes the path of least resistance, often ignoring minor changes in 
riverline direction such as meanders.  Additionally, excessive detail, such as digitizing meanders, can lead 
to overestimation of the flow path length and, consequently, floodplain storage, resulting in over 
attenuation of dam break discharges.   

Cross Sections (Required) 
The cross section features are the key to producing a SMPDBK file and are stored in the S_Dams_XS_Ln 
feature class.  Placing the cross sections appropriately is important. GeoDam-BREACH uses the cross 
sections in combination with the elevation information to produce the elevation-topwidth tables in the 
SMPDBK input file. The cross section table defines the left- and right-bank inactive area limits and also 
allows for entry of a Manning’s roughness coefficient.  
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Background Information for Creating SMPDBK Cross Sections  

SMPDBK uses distance weighting for average section properties. Users should place cross sections 
where major changes in valley width begin and end. 

In order to produce the top width vs. depth series for each cross section in the SMPDBK input file, 
GeoDam-BREACH subdivides each section area into SMPDBK slices and computes the area within 
each slice using the basic algorithm developed by the NWS and documented in “GeoSMPDBK: 
Instructions” (Reference 8). The application then creates a series of stacked trapezoids, each with 
the same area as the corresponding slice. These stacked trapezoids define the top widths, which are 
printed to the SMPDBK input file and used to compute the hydraulic properties of the reach. 

The translation to top width vs. depth pairs from area vs. depth pairs via this method of trapezoids 
introduces a small complication. The complication arises because there are infinite combinations of 
trapezoids that produce the correct area calculation for a given set of slices. The GeoSMPDBK 
algorithm chooses the set of trapezoid top widths that produce the smoothest side slope from top to 
bottom, constrained so that the areas of the trapezoids match the corresponding slices through the 
real cross section.

The first cross section should be placed just below the dam and subsequent sections should be 
placed at points of interest where depth-of-flow information is desired. SMPDBK will run with a 
minimum of two cross sections in the input file, but additional cross sections should be placed to 
capture variability in the floodplain width. For example, at least one cross section should be placed 
before, in the middle of, and after any dramatic changes in floodplain width. Look for floodplain 
changes below major junctions to see if a cross section is needed. See below for an example of 
appropriate section placement. 
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If a user has existing cross sections, then these can be imported by selecting Import Layer -> Cross 
Section from the main Dashboard menu. 

1. To create cross sections, open up an editing session (or keep open) and follow the same
procedure used for creating the river centerline; however, in the Create Features window on the
right of the ArcMap document, select S_Dams_XS_Ln, which changes the target for creating
features to the cross section line layer.  Cross sections should be digitized from left to right
looking in the downstream direction.

Symmetric trapezoid representation of cross sectional area with no slicing optimization. 

*Note that the zero width of the bottom trapezoid is constraining the geometry of the rest of  the 
trapezoids and creating the see-saw effect in the three uppermost widths. For the topwidth  to 
decrease, the bottom would have to also decrease, which is not possible.

This tends to happen when there are large changes in channel area with small increases in depth, such 
as with the abrupt transition from a channel to a broad floodplain. This can also occur if a section is 
drawn crossing multiple channels, as may happen near a confluence. Although “Christmas tree” or see-
saw cross sections created in these cases are not aesthetically pleasing, they do maintain the correct 
area-elevation curves from the DEM, and the resulting flow and depth calculations at these cross 
sections are physically realistic model estimates. 

The upstream most cross section must be located at the downstream toe of the dam because 
the lowest elevation of this cross section will be used by SMPDBK to determine the invert 

elevation of the reservoir. 

Sometimes the area constraint on the trapezoids has the effect of causing a see-saw alternation of 
widths giving the appearance of an upside-down “Christmas tree;” as one width is increased, the 
adjacent widths decrease, with the area acting as the see-saw point. It is possible for this see-saw 
pattern to appear as the optimal case when the bottom trapezoid is constrained to a zero bottom 
width (See below). 



3. Digitize cross
sections from left to
right capturing large 
changes in valley
width.  Single click to
start line and create 
vertices; double click to
create last vertex and 
finish cross section.

Create the first cross 
section at the 
downstream toe of 
dam 

2. Click Create Features

 1. Select
S_Dams_XS_Ln
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Inactive Areas (Optional) 
Inactive areas represent portions of a cross section that provide minimal conveyance (dead storage). 
This can include the outer parts of a wide floodplain or backwater areas.  Inactive Areas are stored in the 
S_Inactive_Ar layer.  Users can identify inactive areas within GeoDam-BREACH by digitizing polygons 
using the S_Inactive_Ar layer.   

1. Select S_Inactive_Ar

3. Digitize the inactive 
area, intersecting with 
all inactive portions of
a cross section

2. Click Create Features
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Upstream Inundation Areas (Optional) 
Upstream inundation areas represent the pool of the reservoir at time of breach and are only needed if 
using the Reservoir Surface option in Reservoir Parameter Setup.  Upstream inundation areas are 
stored in the S_US_Inundation_Ar layer.   

If users have existing reservoir polygons that represent the reservoir area at time of breach, then these 
can be imported by selecting Import Layer -> Upstream Reservoir from the main Dashboard menu. 

Users can identify upstream inundation areas within GeoDam-BREACH by digitizing polygons using the 
S_US_Inundation_Ar layer and creating a polygon in the same way that the Inactive Areas layer was 
illustrated above.   

Cross Section View and Advanced Functions (Optional Functions) 
GeoDam-BREACH provides tools for viewing and reviewing individual cross sections, as well as 
performing advanced functions like individually setting cross section Manning’s N values, adding rating 
curves and developing synthetic hydrographs. 

View/Edit Cross Sections 
The View/Edit Cross Sections button is found at the bottom of the Basic Setup tab and provides tools 
for viewing and editing individual cross sections.   

1. Click on View/Edit Cross Section to access these tools.

Users can select individual cross sections to view from the drop down menu at the top left. GeoDam-
BREACH provides a view of the actual cross section, cut directly from the DEM, and overlaid with an 
image of the simplified symmetrical cross section used to extract elevation-width data pairs for the 
SMPDBK input file.  Users can individually change the cross section Manning’s value for each cross 
section. 
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2. Users can change the 
cross section Manning’s N 
value for individual cross
sections

1. Users can browse through 
individual cross sections

Simplified 
symmetrical cross 
section is illustrated 

Cross section 
extracted from DEM 

Adding Rating Curves (optional) 
This optional function allows the users to improve the accuracy of GeoDam-BREACH studies that utilize 
SMPDBK by allowing the SMPDBK results to be overwritten by a more detailed rating curve at hydraulic 
structures, and then automatically mapping this elevation upstream until SMPDBK elevations exceed the 
backwater elevations.    

To utilize this function, users must place a cross section at the downstream toe of a hydraulic structure 
and assign a rating curve.  The cross section ObjectID can be labeled to enable quick cross referencing 
with the Cross Section Viewer. 
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Cross section must be 
placed on downstream 
toe of embankment 

Rating Curves in GeoDam-BREACH 

Rating curves can be determined using other hydraulic models, such as HEC-RAS or monographs.   
GeoDam-BREACH will initially run SMPDBK and then utilize the peak discharge calculated by SMPDBK 
at the cross section just downstream of the structure.  GeoDam-BREACH will then interpolate the 
flood elevation from the rating curve.   The interpolated elevation will then be applied just upstream 
of the cross section and inundations and results will be updated to reflect the more detailed flood 
elevation.  GeoDam-BREACH does not consider the additional attenuations created by the rating 
curve.    

Users are recommended to carefully review any rating curves and determine whether they 
appropriately represent typical conditions experienced during a dam breach, such as blockage and 
the possibility of structural failure and breaching. 
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1. To add a rating curve, check the “This cross section is bridge or culvert” box in the Cross Section
Viewer.  A new form will appear to the right enabling the rating curve to be entered.

2. Check the box to add 
a rating curve 

4. Select either depth or elevation 
for the rating curve and enter data
pairs

6. Enter the overtopping elevation 
of the road 

1. Select the cross section at 
the downstream of the 
hydraulic structure

3. Enter the structure name

5. Enter the discharge elevation or
discharge depth pairs here.  It is
very important that the last pair
represents a Q higher than the
peak Q at this cross section

7. Save changes to the rating curve 

The overtopping elevation represents the elevation at which the road crossing starts to flood.  Using 
this elevation, GeoDam-BREACH internally creates a synthetic hydrograph ordinate that represents 
the time that the structure begins to overtop.  Additionally, it determines at what time the flood 
recedes to a discharge that does not inundate the road using the rating curve.  This allows the time 
to flood and duration of flooding to be determined for structures modeled using this option. 

Running Simulations and Post Processing 
GeoDam-BREACH provides users with two ways to run a SMPDBK simulation and delineate the 
inundation polygon.   The Batch Process allows users to perform one-click simulations and inundation 
delineation.   The Stepwise Process provides users with a less automated, three-click simulation.  On first 
click, users are able to create the SMPDBK input files, review and perform limited editing.  On second 
click, GeoDam-BREACH will execute SMPDBK and allow users to review the output file. The third and 
final click allows users to perform the inundation delineation. 
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The Batch and Stepwise Processes are located at the bottom of the SMPDBK User Interface.  Once the 
minimal data requirements have been met, the Simulate Dam Breach button will be enabled and can be 
clicked as illustrated below: 

1. Users can select a
Batch or Stepwise Run

3. The Batch or Stepwise runs
can be started using the 
Simulate Dam Breach button

2. If ArcInfo is available,
advanced smoothing routines
can be applied to the floodplain.

Viewing SMPDBK Results 
The inundation polygon will automatically appear in the ArcMap table of contents as 
S_DS_Inundation_Ar once the simulation has completed.  Along with being stored in the SMPDBK 
output file located within the SMPDBK folder for that specific dam, model outputs are also stored within 
a linked database table located within the FGDB and called L_Dams_XS_MDL_Results.  Within this table, 
the results are linked to the S_Dams_XS_Ln feature class by the DAMS_XS_ID field, which is found in 
both datasets. 
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Work Flow 2 – Risk MAP Datasets 
The Risk MAP Datasets Workflow is illustrated below in Figure 2. 

Select Dam from GeoDam-
BREACH Dashboard and Select 
Risk MAP Workflow GIS Data and Model Output 

from Workflow 1 

Datasets need 
further 
processing? 

Data import 
into Risk 
MAP schema 

Inundation Studies 
Created outside of 
GeoDam-BREACH 

Create 
Datasets 

Risk MAP Datasets Creation 
Complete 

Select Risk MAP 
Datasets to 

Create 

YES 

No 

Figure 2. Risk MAP Datasets Workflow 
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GeoDam-BREACH supports the creation of numerous Risk MAP datasets including: 

• Risk MAP Dam Locations (S_RM_Dams_Pt)

• Dams Cross Sections (S_Dams_XS_Ln)

• Dams Cross Section Model Results Lookup Table (L_Dams_XS_MDL_Results)

• Scenario Lookup Table (L_Scenario)

• Upstream Inundation (S_US_Inundation_AR)

• Downstream Inundation (S_DS_Inundation_Ar )

• Depth Grid (Dam_Depth_[SCENARIO])

• Velocity Grid (Dam_VEL_[SCENARIO])

• Flood Wave Arrival Time Grid (Dam_Arrival_[SCENARIO])

• Time to Peak Grid (Dam_Peak_[SCENARIO])

• Flood Inundation Duration (Dam_FID_[SCENARIO])

• Water-Surface Elevation Grid (Dam_WSE_[SCENARIO])

Where [SCENARIO] represents the dam breach inundation scenario presented in the dataset, as 
illustrated in Table 2, Scenario Lookup Table. 

Additional Risk MAP-style datasets are created by GeoDam-BREACH including: 
• Downstream River Line S_DS_River_Ln

o Single river baseline starting at the toe of the dam
• Residual Risk Polygons (S_Res_Risk_AR)

o Polygons that show the additional risk of flooding associated with a dam inundation
that is greater than the FEMA Special Flood Hazard Area at a county level

• Distance from Dam Grid (DAM_DIST_[SCENARIO])
o Raster dataset that depicts the distance from the dam for the inundation extents

• Celerity Grid (Dam_CEL_[SCENARIO])

o Raster dataset that depicts the inundation wave celerity for peak discharge

Background Information for Risk MAP Datasets.  

Risk MAP Datasets are a compilation of data gathered during a Flood Risk Project.  This can include 
floodplain studies, as well as dam inundation studies.  Risk MAP datasets can be used to assess, 
visualize and communicate flood risk.  Risk MAP datasets for dams include a series of vector and 
raster GIS datasets comprised of inundation depth and analysis grids which communicate various 
inundation model results such as inundation depth, elevation, arrival time, time to peak, inundation 
duration and velocity.   Full descriptions of these datasets can be found in the draft FEMA document 
entitled “Proposed Non-Regulatory Flood Risk Datasets – Dams” (Reference 2). 
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Table 2. Scenario Lookup Table 
Event (See D_Event) Release Type 

(See 
D_Release_Typ) 

Reservoir 
Condition (See 

D_Reservoir_Cond) 

0_2 – 0.2% annual chance event 
01 – 1% annual chance event 
02 – 2% annual chance event 
04 – 4% annual chance event 
10 – 10% annual chance event 
PMF – Probable Maximum Flood 
PMF14 – ¼ of PMF 
PMF13 – ⅓ of PMF 
PMF12 – ½ of PMF 
PMF34 – ¾ of PMF 
PMP – Probable Maximum Precipitation 
PMP14 – ¼ of PMP 
PMP13 – ⅓ of PMP 
PMP12 – ½ of PMP 
PMP34 – ¾ of PMP 
SUN – Sunny Day 
FOR – Flood of Record (to be described in 
L_Scenario and metadata) 

Piping 

Overtop 

Gate Failure 

Full 

Normal Pool 

Auxiliary Spillway 

Primary Spillway 

Input Data Requirements 
The minimum digital data requirement for the Risk MAP Datasets Workflow is either a complete dam 
break study created from the SMPDBK Pre- and Post-Processing Workflow, or a dam break study created 
externally with results stored in an ESRI format with appropriate database attributes populated as 
needed by individual Risk MAP datasets.  The comprehensiveness of the externally derived data may 
influence which Risk MAP datasets can be created.    
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Using Risk MAP Datasets Tools 
1. To launch the Risk MAP Datasets Workflow, simply highlight the dam in the Dashboard and

select the Risk MAP Datasets launch button, as illustrated below:

1. Select the dam here

2. With the dam selected, click Risk MAP Datasets to
launch the Risk MAP workflow (note that if the 
SMPDBK workflow is complete, the status is shown as a
green check mark.  Since the Risk MAP datasets have 
not been started, they are shown as a red X.)

The Risk MAP Datasets Workflow provides the user with two approaches for creating Risk MAP 
datasets.  The first approach allows the direct use of inundation studies previously created through the 
SMPDBK Workflow of GeoDam-BREACH.  The second approach allows users to import both vector and 
raster datasets from inundation studies performed outside of GeoDam-BREACH.  This can include 1-D 
HEC-RAS studies and 2-D models.   To be compatible with GeoDam-BREACH, these datasets must be in 
ESRI compatible formats.  If the SMPDBK Workflow is complete, GeoDam-BREACH will automatically 
launch the Risk MAP toolsets for SMPDBK Data Inputs.   If the SMPDBK Workflow has not been 
performed, then GeoDam-BREACH will automatically open the Import External Datasets toolsets.   
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Risk MAP Datasets for Inundation Studies Created Using the SMPDBK Pre- and Post-Processing 
Workflow 
Within the Risk MAP Datasets Workflow window, GeoDam-BREACH automatically recognizes river 
centerlines, cross-section lines, inundation polygons and model results generated from the SMPDBK 
Workflow.  The user must identify the DEM layer to be used for generating Risk MAP datasets.  Users 
can then check the required boxes for individual Risk MAP Datasets.  

1. Select the DEM and 
vertical units here

3. Select the Risk MAP
Datasets required.

2. Select the DFIRM
flood hazard polygons
only if Residual Risk
Polygons are required.

4. Create Risk MAP datasets 
button will become active 
when datasets are ready to
process.
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Risk MAP Datasets for Inundation Studies Created Outside of GeoDam-BREACH 
GeoDam-BREACH allows users to import both vector and raster datasets into the GeoDam-BREACH 
study using Risk MAP Dataset formats.  To import external datasets, users must first initiate a GeoDam-
BREACH study and create a dam using the Add Dam Point function.  This creates the empty schema for 
Risk MAP products.   To create Risk MAP products, the user should select the dam and then select the 
Risk MAP Datasets Workflow.  To import an external dataset, select the Import External Layers tab in 
the Risk MAP Datasets Workflow.  The user must then select the Scenario by identifying Release Type, 
Event Description and Reservoir Condition.   

Importing Vector 1-D Model Data 
The external datasets must contain the following features and attributes: 

• Downstream River Line 
o Single river line digitized from the downstream toe of the dam to the downstream limit 

of study 
• Inundation Polygon 

o Polygons of the resulting inundation 
• Cross-section Lines 

o Cross sections indicating alignment attributed with: 
 Water-surface elevation in feet (Double) 
 Flood arrival time in hours (Double) 
 Flood time of peak in hours (Double) 
 Flood Duration in hours (Double) 
 Cross-section ID (Long) 
 Cross-section stationing (Double) 

To import the layers into a Risk MAP format, the downstream river line, inundation polygon and 
downstream cross-section layers must be identified or added through the Import Layers (1-D Model) 
section of the Import External Layers tab.   The cross-section attributes must then be mapped as 
illustrated in the next image.   

Once these layers are selected and the cross-section fields are mapped, the data is ready to import using 
the Import button.   
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1. Select the scenario of 
the inundation 

2. If using 1-D model 
outputs, select the 1-D 
layers to import 

3. Map out the cross 
section fields 

4. Click to Import 1-D 
features into Risk MAP 
dataset formats 

5. Select the DEM 
and DFIRM Flood 
Hazard Layer (if 
Residual Risk 
Polygons are 
required) 

6. Select datasets 
to create.    

7. If new features are to be developed from 1-D 
data, then select Create a New Raster.  If 2-D 
model grids or 1-D model grids developed 
outside of GeoDam-BREACH are to be imported 
into the Risk MAP format, then select or 
browse to these files.      

8. Create Risk MAP datasets 
button will become active 
when datasets are ready to 
process. 
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Viewing Results 
Once GeoDam-BREACH has finished creating Risk MAP Datasets, these datasets will automatically 
appear in the ArcMap Table of Contents and can be turned on and off as desired.   The raster values can 
be queried using the standard ArcMap Identify function, which allows users to click on any feature and 
query the raster or vector values and attributes.    

If datasets do not appear after the “Risk MAP Datasets Complete” message appears, they can be 

manually added by opening up the project folder using the  in the bottom left of 
the Dashboard and browsing to the GISData folder and adding the datasets from the root of the 
DamBreach.gdb FGDB. 

All data is stored within the study folder (.dbk).  Tabular and raster data is stored at the root level of the 
database: 

\[NID ID]\GISDATA\damBreach.gdb\RiskMAP 

Vector data is stored in the RiskMAP feature dataset: 

\[NID ID]\GISDATA\damBreach.gdb\RiskMAP 

The vector cross sections are stored in a linked database table located within the FGDB and called 
L_Dams_XS_MDL_Results.  Within this table, the results are linked to the S_Dams_XS_Ln feature class 
by the DAMS_XS_ID field found in both datasets: 

[Study Folder .dbk] \[NID ID]\GISDATA\damBreach.gdb\RiskMAP 
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Work Flow 3 – Loss of Life Assessment 
The Loss of Life Assessment Workflow is illustrated in Figure 3 below. 

 
 
 

 
 
 

User Supplied 
Population 
Polygons  

Loss of Life Assessment Report Complete 

1. Specify Dam Type
2. Determine whether there 

are observers at dam
3. Identify first populated area 

reference point
4. Specify failure type 

Simulate Loss 
of Life 

Manually provided 
warning initiation 
(optional overriding 
calculated values) 

Arrival Time 
Grids from 
Workflow 2 

Select Dam from GeoDam-
BREACH Dashboard and Select 
Loss of Life Assessment 
Workflow.  

Choose methodology: DSO 
Procedure (DHS 2011) or Brown 
and Graham Method (1988)  

Brown and 
Graham Method 
(1988)  

Determine 
Warning Times 

Test early 
warning and 
detection? 

Determine increased warning 
time using “virtual observer” to 
simulate early detection at dam 

Yes No 

DSO Procedure 
(DHS 2011)  

Determine 
Warning Times 

Identify flood severity 
understanding (vague, 
precise) 

Identify flood severity 
categories (high, 
medium, low)  

Figure 3. Loss of Life Assessment Workflow 



40 

Using Loss of Life Tools 
1. To launch the Loss of Life Workflow, simply highlight the dam in the Dashboard and select the

Loss of Life button as illustrated below:

1. Select the dam here

2. With the dam selected, click Loss of Life to launch 
the Loss of Life Workflow 

The Loss of Life user interface will now appear.  

Two methods for calculating the probable Loss of Life are presented in the GeoDam-BREACH program.   
These two methods are presented in the DHS (2011) document Dam Sector: Estimating Loss of Life for 
Dam Failure Scenarios (Reference 3):  

• Bureau of Reclamation DSO-99-06 Flood Severity Method
• Brown and Graham Method

Users are expected to have a thorough understanding of the inputs, methods and limitations of both 
methods. 

DSO Procedure 

The DSO Procedure is the recommended method for estimating loss of life resulting from dam failure. 
This procedure is based on an analysis of dam failures, flash floods and floods located in the U.S.  The 
procedure can be used to estimate when a dam failure warning would be initiated.  It provides 
estimated fatality rates based on flood severity, warning time and warning quality that can be used to 
estimate the probable loss of life from a dam failure (Reference 3).  Advantages and limitations to this 
procedure are provided in the DHS document.  The DHS procedure provided within GeoDam-BREACH is 
based on the DSO document A Procedure for Estimating Loss of Life Caused by Dam Failure, DSO-99-06, 
September 1999 (Reference 4).  
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Input Data Requirements 

To perform a probable loss of life assessment using the DSO Procedure, GeoDam-BREACH requires a 
digital dataset containing the structures/buildings downstream of the dam and attribute fields with the 
daytime and nighttime population of each structure.  Additionally, GeoDam-BREACH requires user input 
to determine the warning initiation and flood severity including:  

• Dam type (earthen, concrete) 
• Failure type 

o Failure caused by piping during normal weather conditions, 
o Failure caused by an earthquake during normal weather conditions, 
o Failure caused by a flood which results in high reservoir levels or dam overtopping, and 
o Failure caused by intentional human actions under highest reasonable reservoir levels 

(worst reasonable conditions) 
• Are there observers at the dam? (yes, no) 
• Failure period (immediate, delayed) 
• Drainage area of the dam (less than or greater than 100 sq. mi.) 
• Flood severity understating (vague, precise) 
• Flood severity categories (high, medium, low)  

Steps for Using the DSO Procedure to Estimate the Probable Loss of Life 
1. Methodology - Select the “DSO Procedure (DHS 2011)” from the methodology drop-down box.  

 
2. Population - Select the GIS shapefile that contains the buildings/structures downstream of the dam, 

as part of this study.  Next, select the attribute fields containing the daytime and nighttime 
population data.  

 
 

3. Cause of Failure - Select the cause of failure associated with this study.  Depending on the dam type 
and reservoir condition selected in Work Flow 1 SMDBK, only applicable failure scenarios will appear 
for selection.  

4. Warning Time - This step is used to estimate when a dam failure warning would be initiated. To 
estimate the breach warning time at the first area downstream of the dam that may be flooded, the 
following information is needed: 

• Type of dam: This field will automatically be populated from the selection of dam type 
made in Work Flow 1.  
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• Failure Period: Immediate or delayed. (this field is only applicable to seismic dam 
failures) 

• Drainage Area at dam: Less than or greater than 100 sq. miles.   
• Observers at dam: Yes or No.  A “yes” means that a dam tender lives on high ground and 

within sight of the dam, the dam is visible from the homes of many people, or the dam 
crest serves as a heavily used roadway.  These dams are typically in urban areas.  A “no” 
means that there is no dam tender at the dam, the dam is out of sight of nearly all 
homes, and there is not a roadway on the dam rest.  These types of dams are typically in 
remote areas.  

 
For earthen dams, the GeoDam-BREACH program will calculate the breach warning initiation 
time based on the criteria entered above.  The calculated times may be edited by selecting the 
Edit button to the left of the calculated time results. For concrete dams, the user is responsible 
for manually entering an appropriate breach warning initiation time for both day and night 
conditions.  
 

 
5. Flood Severity Understanding - Select the flood severity understanding of the downstream 

conditions from a dam failure for both day and night.   Draw a polygon around the vague 
understanding area downstream of the dam.  All other areas within the inundation boundary not 
contained within the vague understating area will be associated with a precise flood severity 
understanding.  
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The DSO Procedure (Reference 3) uses the term “Flood Severity Understanding” to describe the 
degree to which the events about to unfold are understood. These are classified into two 
categories:  

• Vague Understanding: Warning issuers have not yet seen the dam fail or do not
comprehend the true magnitude of the flood that is about to ensue.  Dam failure is a
possibility, but not certain to occur. Less forceful warnings are anticipated.

• Precise Understanding: Warning issuers have an excellent understanding of the flooding
due to observations of the flooding.  Dam failure is in progress or has occurred.  Strong
and forceful warnings are anticipated with this type of warning.

6. Flood Severity Categories - Identify and select the flood severity categories of high, medium and low
associated with the downstream flood severity conditions.  Draw a polygon around the high flood
severity category area by selecting the high button. If a high flood severity area does not exist, omit
this step.  Next, define the low flood severity area by drawing a polygon around that area using the
low button.  An area within the inundation boundary that is not contained within a high or low flood
severity category polygon is automatically considered a medium flood severity area.   Guidance is
provided in the DHS publication for selecting the flood severity categories.

7. Provide a description of each flood severity category including upstream and downstream limits, a
description of the land use or habitants, number of buildings, etc., as appropriate.  This description
is not used in the procedure for calculations, but is included in the output results along with the
calculated population at risk in each flood severity category.

8. Calculating Loss of Life - Once all of the data is entered into the GeoDam-BREACH program for this
methodology, select the Calculate Loss of Life button to determine the probable loss of life using
the DSO Procedure.

9. Viewing Results - GeoDam-BREACH automatically saves the results of the loss of life assessment
inside the GeoDam-BREACH study folder (.dbk).  In the folder of the individual dam, the loss of life
report is stored within the LossOfLifeDSO folder in Microsoft Word format.



 

44 

 

 

Brown and Graham Procedure 
The Brown and Graham procedure is an older approach than the DSO procedure flood Severity method.  
Although it is recommended that the DSO procedure flood severity method be used, the Brown and 
Graham procedure provides a simplified approach that requires less input data. Advantages and 
limitations to this procedure are provided in the DHS document.  The Brown and Graham procedure 
provided within GeoDam-BREACH is based on the DSO document A Procedure for Estimating Loss of Life 
Caused by Dam Failure, DSO-99-06, September 1999 (Reference 4). 

Background Information for Loss of Life Estimation Using the Brown and Graham Method 

Warning time used in the equations is defined as the elapsed time between the initiation of an 
official evacuation warning to the public and the arrival of dangerous flooding to the population at 
risk (PAR). Warning time must therefore consider the time it takes for flood water to reach the 
community or group of people at risk. 
 
When warning time is less than 15 minutes: 

Loss of Life = 0.5 × (PAR) 

When warning time is between 15 and 90 minutes: 
Loss of Life = PAR0.6 

When warning time is more than 90 minutes: 
Loss of Life = 0.0002 × (PAR) 

 
It is easy to see that the loss of life estimate based on these relationships will vary widely depending 
on the warning time. With 5,000 people at risk, loss of life from dam failure could be as much as 
2,500 people if these people are located in an area that receives less than 15 minutes of warning. In 
comparison, the estimated loss of life would be 1 if the PAR is located in an area that receives more 
than 90 minutes of warning. 
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Input Data Requirements 
To perform a probable loss of life assessment, GeoDam-BREACH requires the following digital datasets: 

• Arrival time grid (created during Workflow 2 or referenced outside of GeoDam-BREACH)
• Population polygons (polygons populated with population data)

Additionally, GeoDAM-BREACH requires user input to determine the warning initiation.  If fully 
attributed in the S_Dam_Pts Risk MAP dataset, much of this data will be automatically populated: 

• Dam type (Earthen, Concrete)
• Failure type (seismic, overtopping, etc.)
• Are there observers at the dam?
• How long until the inundation reaches the first downstream populated area (for dams with

no observers or automatic breach detection to detect failure)?

Calculating Warning Time 
GeoDam-BREACH uses the recommendations of DSO 99-06, specifically Table 2 on Page 15 of Reference 
4, to estimate when dam failure warnings would be initiated.  For concrete dams, GeoDam-BREACH 
utilizes the procedures for earthen dams with the assumption that the breach warning is initiated no 
earlier than breach initiation.   



2. Select population polygons

3. Select fields attributed with 
daytime and nighttime 
population (must be Double)
and provide source citation

4. Select dam type, cause of
failure (if not auto-populated 
from previous GeoDam-BREACH
data entries) and drainage area

User can override calculated 
values for Breach Warning 
Initiation if desired 

5. Identify whether there are 
observers at dam (see below)

6. If no observers are at dam,
identify where breach will be 
detected

Check box to include a basic 
assessment of early warning 
effectiveness for dams with no 
observers 

7. Click button to perform Loss of 
Life Assessment

1. Select Brown and Graham Method 

46 

1. Methodology
Methodology allows users to select the method for assessing Loss of Life.

2. Breach Scenario
This allows the user to select which scenario to assess.   Currently GeoDam-BREACH only supports
running one scenario.

3. Warning Time
If the type of dam and cause of failure have already been identified previously within GeoDam-BREACH,
these fields will be automatically populated.  The Drainage Area at Dam is required for earthen dams.

If there are no observers at the dam, then the inundation is unlikely to be detected until it reaches the 
first populated area downstream.  This can cause a significant delay in detecting the breach.   A 
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populated area can be a busy road or a subdivision.  Users must use their judgment when selecting 
where the breach will first be detected.   To identify this area, click on the Identify button within the 
Loss of Life interface. GeoDam-BREACH will then prompt the user to identify the location by clicking 
within the inundation and providing a description of the area where the inundation will first be 
detected. 

GeoDam-BREACH will use this area to determine from the arrival time grid how long after the breach 
initiation the flood wave arrived, and will then calculate the appropriate warning initiation delay. 

The override defaults allow users to provide their own values for a daytime and nighttime breach 
warning initiation.   If the warning occurs after the breach, then values should be entered as negative 
values in minutes.   

4. Report
For dams that do not have an observer, GeoDam-BREACH provides an option that automatically
performs an additional calculation that assumes there is an observer at the dam.  An observer can also
simulate the effects of an early detection system, such as a downstream gage that is remotely
monitored, thereby creating a virtual observer.  When using this option, GeoDam-BREACH automatically
provides a summary of the potential reduction in Loss of Life.

To utilize this option, simply check the box titled Include Early Detection Assessment. 

Calculating Loss of Life 
Once all data is entered for the Loss of Life calculation, the user can select Calculate Loss of Life.  
GeoDam-BREACH will determine the warning provided to each individual population polygon based on 
the breach warning initiation and arrival time.   GeoDam-BREACH will then calculate the PAR for various 
time intervals and apply empirical equations for loss of life.    

Viewing Results 
GeoDam-BREACH automatically saves the results of the Loss of Life assessment inside the GeoDam-
BREACH study folder (.dbk).   Within the folder for the individual dam, the Loss of Life Report is stored 
within the LossOfLife folder in Microsoft Word format.  Users will be prompted to open the report once 
it is complete. 
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Work Flow 4 – EAP Mapping 
The EAP Mapping Workflow is illustrated in Figure 4. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Inundation Polygons 
from Workflow 1 
(SMPDBK) and Workflow 
2 (Risk MAP) 

Set Page and Scale 
User specifies: 
i. Map scale 

ii. Map panel size 

Auto Annotate 
and Symbolize 
Structures and 
Point of Interest 

PDF of Map Panels Created 

Inundation Polygons and 
arrival time grids from 
outside of GeoDam-
BREACH 

Select Dam from GeoDam-
BREACH Dashboard and Select 
EAP Mapping Workflow 

Set Map Extent 
and Create Panel 
Layout 

User identifies required extent of 
mapping 

User provides additional points of 
interest and structure information 

Auto Create Map 
Panels 

Figure 4. EAP Mapping Workflow 
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This workflow was designed to produce an EAP map that is editable in GIS.  The user should expect to 
edit the maps for text overlaps, style and sizing exterior of the toolset. 

Input Data Requirements 
To create EAP maps, users are recommended to provide the following GIS base map elements not 
provided by GeoDam-BREACH so that map users will have visual points of reference: 

• Aerial imagery (highly recommended) 
• Vector road feature for labeling of road names (highly recommended) 
• Corporate limits for labeling of county and city boundaries (highly recommended) 
• Parcels 
• Building footprints 
• Other features as required by user 

The following datasets, which must be created or imported during the SMPDBK and/or Risk MAP 
Workflows, are required for the EAP map creation: 

• Dam points (from S_RM_Dams_Pt created from Dashboard) 
• Stream Centerline (S_DS_River_Ln created during SMPDBK or Risk MAP Workflows) 
• Inundation Polygon (S_DS_Inundation_Ar created during SMPDBK or Risk MAP Workflows) 

Additional datasets created during the SMPDBK and/or Risk MAP Workflows are recommended and will 
facilitate auto annotation for road crossings and points of interest: 

• Structure Points for automatic labeling of time to overtop, depth of over topping and duration 
of overtopping for road crossings (S_Structure_Pt created during SMPDBK from rating curves) 

• Upstream Reservoir for automatic display of upstream reservoir (S_US_Inundation_Ar created 
or imported during SMPDBK and/or Risk MAP Workflows) 

• Arrival Time Grid for automated labeling of arrival time for points of interest 
(DAM_Arrival_[event scenario] created or imported during Risk MAP Workflow) 

• Depth Grid for automated labeling of depth for points of interest (DAM_Depth_[event scenario] 
created or imported during Risk MAP Workflow) 

• Inundation Duration Grid for automated labeling of inundation duration for points of interest 
(DAM_FID_[event scenario] created or imported during Risk MAP Workflow) 

Using the EAP Mapping Tools 
To launch the EAP Mapping Workflow, highlight the dam in the Dashboard and click the EAP Mapping 
button (see illustration below). 
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Select the dam here 

With the dam selected, click EAP Mapping to launch 
the EAP Mapping workflow 

Note: Clicking the EAP Mapping button will launch the Map Panel Generation Dashboard and create a 
new map document (8x11M.mxd). The current map must be saved before clicking EAP Mapping. 

Creating Individual Map Panels 
1. Open ArcMap. Make sure the current map document is saved (clicking the EAP Mapping button

will create a new map document 8x11M.mxd).  Clicking the EAP Mapping button also launches
the Map Panel Generation Dashboard (see illustration below). The following sections will help to
complete the Map Panel output:

a. Output Location, Page Size, Map Scale
b. Map Title
c. Set Extent and Create Panels
d. Customizing Map Panels Annotation & Structures and Points of Interest Labels
e. Output
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2. With the Map Panel Generation Dashboard open, the first step is to set the Page Size and Map
Scale (like the map document automatically created 8x11M.mxd, the default page size is 8x11).
To change the Page Size and Map Scale, click the Set Page and Scale button as illustrated above.
Note the Output Folder Location; this cannot be changed. Choose a Page Size from the three
options (8x11, 11x17 and 24x36) and choose a Map Scale from the pull down list.
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3. Add any basemap feature layers as desired and label where necessary.  This step can be 
performed at any stage prior to creating output and can include: 

a. Aerial imagery.   It is recommended that aerial imagery be set to 50% transparency so 
that it does not overpower the more critical information, such as the inundation 
polygon.  The transparency level may vary depending on the brightness and general 
shades of imagery. 

b. Vector road features.  It is recommended that vector road features be added and used 
to label roads.  It is also recommended that each label contain a halo in order to be 
readable against aerial basemaps.  The font size of labels should be chosen 
commensurate with the map panel scale. 

c. Corporate boundary features.  It is recommended that corporate boundaries be added 
and used to label city and county names.   It is recommended that either line features or 
hollow polygons be used and labeled with a halo so that they are readable against aerial 
basemaps.  The font size of labels should be chosen commensurate with the map panel 
scale. 

4. By default, the map panels are titled with the dam name. However, the user may provide a 
different name if desired in Section 1. Map Title. 

5. In the section Map Extent and Panels, click the Set Extent and Create Map Panels button. Once 
in the map document, use the cursor to draw the desired area of extent. A “Start Map Panel 
Creation” popup will appear. Click “OK” and allow a few moments for the panels to be created. 
A “Map Panels Created!” popup will appear indicating that GeoDam-BREACH has created the 
panel schema. Click “OK” to continue. 

6. With the panels now drawn (see illustration below), users can add graphics and annotation as 
needed. 
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Customizing Map Panel Annotations 
1. The map will load data and map symbology will be based on one of three predetermined 

templates (8x11, 11x17 and 24x36 page sizes).  Once the tool has loaded the appropriate map 
template and data, users can modify and save the document before using the tool to produce 
the map book (i.e., map panels).  These modifications can include adding more data layers, 
modifying current layers and adding custom graphics and annotations.  However, the location of 
the map document, its name and its basic structure (especially the layout page) should not be 
modified, as this can cause problems during map panel generation.  The tool will not overwrite 
these changes the next time the document is opened.  To start from scratch without the 
customizations, simply delete all the files in the output folder.    

2. Additionally, three options are available for adding labels to structures and points of interest 
(see illustration below). 
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3. The Label Existing Structures function will automatically label inundated road crossings with the
time to, duration of and depth of road overtopping.  This function is only available for
inundation studies performed using the SMPDBK Workflow, and more specifically, the Add
Rating Curve function.   The S_Structure_Pt feature class is used to automatically drive this
labeling.

4. The Create New Structure function will allow the user to add a label to the map for road
crossings. This is intended for studies performed outside of GeoDam-BREACH and imported
during the Risk MAP Workflow.  Click the Create New Structure button and using the cursor in
the map document, click on the location of the inundated road crossing. Fill out the dialog box
and click “Save” (see illustrations below).
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5. The Create Point of Interest function can be used to annotate points of interest within or 
adjacent to the inundation zone with information pertaining to depth of flooding, arrival time 
and inundation duration.   The points of interest may include: 

• Critical facilities such as hospitals, fire stations, police facilities, etc. 
• Areas at high risk/concern such as subdivisions, schools, churches, senior living facilities, 

hazardous materials, etc. 
• Critical infrastructure such as pump stations, water treatment facilities, power 

distribution facilities, etc. 
 

The Create Point of Interest function requires the user to enter only a description (see 
illustrations below) and arrival time; depth and duration information will be automatically 
populated based on raster datasets created during the Risk MAP Workflow.  If these datasets 
are not available, depth, duration and time of arrival will be labeled as 0 by default.  The user 
must then manually edit the labels within the map.   
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6. The Delete All Labels button will delete any existing labels on the map that were created using 
any of the three previously discussed buttons (Load Existing Structures, Create New Structures 
or Create Point of Interest).  Labels can also be deleted manually by selecting individual map 
elements and deleting them.   

Tips for Labeling Panels 

When placing, viewing and editing all labels and annotations, it is recommended the viewing scale of 
the Map document be set to the same scale as the desired panel output in the ArcMap Tools Toolbar.   

For example:  when using 1:6,000 scale panel outputs.   
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Creating the PDF Output 
1. The final step in the EAP Mapping Workflow is to create a Portable Document File (PDF) output 

Map Book. Under the Output section, click the Create Output button. A “Start Map Book 
creation” popup will appear. Click “OK” to continue. The tool may run for several minutes to 
over an hour depending on the number and size of panels and the resolution of base map 
features.  Once finished, GeoDam-BREACH will automatically open the map book PDF 
document. 
 

2. You have the ability to go back and add/remove labels and annotation if desired. If new labels 
have been added since the last Output was generated, the Status box will be populated with the 
message “Labels have changed, new output is needed” (see illustration below). Follow the same 
Create Output procedure to create an updated Map Book. 
 

 

Viewing Map Panel Outputs 
The Map Book Output is always saved in the .dbk study folder in the corresponding [Dam Name] -> 
EAPMapping folder.  The first output is a PDF called “EAPMap.pdf” and it contains all map panels in a 
single file.  The second output is called “EAPMapImage.zip” and is a compressed file containing separate 
images for each individual map panel in a Portable Network Graphics (.PNG) file format.   Additionally, 
there are three map documents (.mxd files).  These correspond to the three page sizes described 
above.  Finally, a number of layer files (.lyr extension) are also in this folder. These include symbology 
and relative paths to the data used in the map. 
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Work Flow 5 – EAP Development 
The EAP Development Workflow is illustrated below in Figure 5. 
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Figure 5. EAP Development Workflow 
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Background Information for EAP Development 

An EAP is a plan of action to reduce the potential for property damage and loss of life in the event of 
a disaster.   EAPs are commonly developed for failures and incidents related to high hazard potential 
dams and some lower hazard potential dams.   EAPs can contain, but do not always require 
inundation mapping; however, an inundation map makes an EAP a much more effective product. 
EAPs can be used by a variety of stakeholders including dam safety officials, mitigation planners and 
emergency responders.  Since EAP maps are intended to be used in an emergency, it is critical that 
the maps can be easily reproduced without losing critical information caused by duplication using 
equipment such as black and white copy machines. 

Input Data Requirements 
While there are no required fields, the generated EAP will display “This question has not been 
answered” for every field where no entry is made, signaling the user to manually enter this data within 
Microsoft Word. GeoDam-BREACH will also leverage any available data previously populated during the 
GeoDam-BREACH Workflows.   

Images or photos to be uploaded must be less than 500kb. 

Using the EAP Development Tools 
To launch the EAP Development Workflow, simply highlight the dam in the Dashboard and select the 
EAP Development launch button as illustrated below: 

Select the dam here 

With the dam selected, click EAP Development to 
launch EAP Development Workflow 
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Please note that if the EAP Development Workflow does not launch, the user should check that the 
necessary Microsoft .NET Framework, as described in the section entitled Software Requirements, 

has been installed. 

 

Overview 
Two EAP templates are available within GeoDam-BREACH; one is based on the 2007 NRCS Sample EAP 
“Fillable Form” (Reference 6) and the other is based on guidance provided in the FEMA publication 
FEMA P-64, Federal Guidelines for Dam Safety: Emergency Action Planning for Dams, July 2013 
(Reference 7).   

The NRCS Sample EAP “Fillable Form” can be found at 
 http://www.nrcs.usda.gov/Internet/FSE_DOCUMENTS/stelprdb1042130.doc 
  
FEMA P-64 (Reference 7) can be found at:  
http://www.fema.gov/media-library/assets/documents/3357?id=1672 
  
While both templates are similar, they contain slightly different information and are arranged in a 
different order.  When determining which EAP template to select, users should keep in mind the 
intended use of the EAP and what data is available to populate the EAP.  Consideration should also be 
made to follow any State and/or Federal reviewing regulatory agency standards and preferences.     

Once the appropriate content is entered into the EAP Report Development interface, a Microsoft Word 
document of the EAP can be generated.  This Word document is editable and additional information and 
revisions can be made directly within the document.   

Developing an EAP 
Entries made in the GIS interface for the fields below are automatically transferred and displayed in the 
EAP application if previously populated or developed in other GeoDam-BREACH workflows. 

Basic EAP Data, Dam Characteristics: 

• Dam Name 
• NID # 
• Latitude 
• Longitude 

 
Model Output Data, Appendix B-5 (footer): Modeling Assumptions: 
 

• What hydraulic model was used?  
• What are the model assumptions for:  Water-surface elevation in reservoir prior to breach at 

top of dam? 
• What are the model assumptions for:  Height of water at time of breach (ft)? 
• What are the model assumptions for:  Peak breach discharge (ft3/s)? 



62 

• What are the model assumptions for:  # of cross sections?

While it is true that these data can be edited on the EAP form for the document, this should be the 
exception, as the change will not be reflected within the application data if changed within the GIS 
interface. 

Disclaimer: Data appearing in the application screenshots is intended to serve as an example only. 
These data should not be relied upon as true and correct.  Likewise, contact names and phone numbers 
are fictitious. 

Navigation: 
The following image displays an example of the application when opened.  The application is structured 
into two panes: the left tree view pane and the right detailed view displaying contents of a selected item 
from the left pane.  In the default view shown in the inset image, the system displays the contents of the 
tree view in a collapsed view.  Each item expands when clicked.  The full tree view is displayed on the 
following page. 

Click the triangle symbol (visible when the cursor hovers over a topic) next to any Menu Item within the 
tree view to expand the topic. The hollow triangle indicates the menu item is minimized.  The solid 
triangle indicates that the menu item is maximized. The left menu items use the tree view and the 
default is a minimized view of the following: 
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Application functionality: 
The following guidance is intended for application areas that require user attention.  Not every data 
entry control will be discussed in the following documentation.  The application used the NRCS template 
(accessible within the Help menu along with a Glossary of Terms) as a general guideline when 
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developing the application.  It is recommended that users refer to that document for additional 
clarification on example content.   

Some fields throughout the application hinge upon entries in other menu areas.  For example: 

Within Basic EAP Data - Dam Characteristics, the Conservation District Name will be populated when the 
Emergency Services Personnel - Emergency Services Roster is completed. 

For the Emergency Services Personnel menu item, within Roles and Responsibilities, the following fields 
can be populated only when the Emergency Services Roster is completed: 

• Dam Operator's Representative 
• Incident Commander 
• Emergency Services Agency 
• Dam Operator's Technical Representative 
• State Dam Safety Agency 

For the Additional Information menu item, under EAP Review and Revisions: 

“What is the title of the individual responsible for EAP Annual Review” and “What organization is 
responsible for EAP revisions” can be populated only when the Emergency Services Roster is completed. 

Screen-specific guidance is displayed to provide further clarification on the functionality of particular 
data attributes. 
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General data entry instructions:

• Select a topic within the tree view and click to display the form (e.g., Dam Characteristics under
Basic EAP Data).

• Fill in all fields manually or by making a selection from a drop down list. Above each input box is
an example of the type of data to be entered, along with applicable guidance.

• Use the vertical and horizontal scroll bars, as available, to access the entire form.
• The icons at the bottom of the page track the completion progress of each form: Not

Completed, In Progress and Completed. Additionally, the date when each form was last updated
will be reflected.

• Clicking the Previous or Next buttons within the application will navigate the user through the
pages.  Additionally, a user can click an item on the left-hand menu bar to navigate to an
individual area out of sequence. Users are prompted to save the data on each form before
continuing.
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Areas of Interest: 
The Five-step EAP Process: Step 2 – Emergency Level Determination: 

The content for Event, Situation and associated Emergency Level from the NRCS template is pre-
populated.  The user can select from the Applicable drop down list if an Event, Situation and Emergency 
Level are applicable to this EAP. 

The user also has the ability to add a new row(s) in the table and can change the width of the columns 
within the grid. 

Step 3 – Notification Flowcharts: Emergency Level 3: 
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The flowchart is based on the NRCS template and is populated in the same manner as all flowcharts 
from the Emergency Services roster—providing drop down lists of identified personnel and their 
respective contact information.  There are also Notification Flowcharts for Emergency Levels 1 and 2.  
These flowcharts are based exclusively on the examples within the NRCS template. 

Generating an EAP: 

 
 

After completing the desired fields for each form, click File and Generate EAP. 

Whenever information has not been entered for a field, the generated EAP will display, “This question 
has not been answered” in red within the document. 
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Once the document is generated in Microsoft Word, it will automatically open and be saved in the .dbk 
study folder in the corresponding [Dam Name] -> EAPDevelopment -> Reports folder. 
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